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Image Viewing, Organizing and Editing Software

ZoomBrowser EX
Ver. 6.4

Instruction Manual

In this manual, ZB is used for ZoomBrowser EX.

In this manual, the windows used in the examples are from Windows XP.

Click on the icons below on the bottom right of the screen to switch 
between pages.

 : Go to next page    : Go to previous page

 : Return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to 
the contents page of each chapter.

© CANON INC. 2009     CT1-7182ZBWE-000
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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM 
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM 
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions 
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided 
that the SOFTWARE is used on only one computer at a time. You shall not install or use the 
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, 
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, 
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 

copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer 
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation 
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for 
use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED 
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period of ninety 
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. 
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge 
when returned by you at your expense to your point of purchase and proven to be defective 
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original 
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if 
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE 
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software 
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of 
the SOFTWARE is subject to the United States, Canada and other applicable copyright and 
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its 
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any 
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON 
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS 
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of ZB
Download images to your computer
Check images
Print images
Organize images
Edit images

Adjust images
Trim images
Insert text
Correct red-eye

Utilize images
Attach an image to an e-mail
Create wallpaper or a screen saver

Convert images
Change image size and type

Play Movies
Use your images with CANON iMAGE GATEWAY

Symbols Used
 : Selection procedure for menus that appear on the computer 

screen
[   ] : Names of items and menus, buttons, windows, etc. that appear on 

the computer screen
<  >: Camera switch name or icon, or a keyboard key name
p.** : Reference page (jump to page by clicking)

: Help : Tip

: Important information : Helpful information

Makeup of Each Chapter
Chapter 1  Basic Operation

Starting up and exiting ZB
Downloading images to your computer
Checking images
Playing movies
Printing images

Chapter 2  Advanced Operation
Efficient checking of images
Organizing images
Editing images
Editing movies
Utilizing images
Index printing 

Chapter 3  High-Level Functions
Checking images with high-level functions
Organizing images with high-level functions
Advanced image editing
Printing with other software

Chapter 4  Preferences
Settings for all functions

Chapter 5  Using Images on the Internet
Using your images with CANON iMAGE GATEWAY

Reference
Solving problems
Uninstalling ZB
System requirements
Supported images
Lists of primary window functions
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Table of Contents
Chapter 1 Basic Operation.................................. 6

Starting up ZB...................................................................7

Downloading an Image to Your Computer........................7
Downloading Images Using Your Card Reader.............9

Viewing an Image ...........................................................11
View Images as Thumbnails in the Main Window .......11

Enlarging a Selected Folder .....................................12
Changing the Display Magnification .........................13

Enlarging and Viewing Images One at a Time ............13
Displaying an Image Across the Whole Window 
(Full View Display)....................................................14

Playing Movies.............................................................15
Rewriting Images to a Memory Card ...........................16

Printing an Image............................................................17
Printing One Image on One Sheet of Paper ................17
Printing an Image Using Easy-PhotoPrint EX..............18

Exiting ZB .......................................................................20

Chapter 2 Advanced Operation ........................ 21
Checking/Sorting Images................................................22

Enlarging and Checking Images One at a Time..........22
Enlarging a Specific Part of an Image ......................23

Sorting Images.............................................................23
Arranging Images in the Main Window ...........................24

Extracting Images You Want to Display 
(Filter Display) ..........................................................24

Efficiently Checking/Sorting Images ............................... 25

Organizing Images ......................................................... 26
Creating a Folder for Saving Images........................... 26
Moving Images ............................................................ 27

Moving Images in Folders ........................................ 27
Changing Image File Names or Folder Names ........... 28
Deleting Images........................................................... 28

Deleting Folders ....................................................... 29
Registering Frequently-Used Folders as Favorite 
Folders......................................................................... 29

Deleting Favorite Folders ......................................... 30
Editing an Image............................................................. 31

Automatic Adjustment Using ZB.................................. 31
Adjusting Brightness, Color and Contrast.................... 33
Trimming an Image...................................................... 34
Inserting Text into Images ........................................... 35
Adjusting Sharpness.................................................... 36
Correcting Red-Eye Automatically............................... 37

Correcting Red-Eye Manually .................................. 37
Editing Movies ................................................................ 38

Cutting Movies............................................................. 41
Utilizing Your Images...................................................... 43

Viewing Images as a Slide Show ................................ 43
Sending an Image by E-Mail ....................................... 44
Creating Wallpaper from an Image.............................. 45
Creating a Screen Saver from an Image..................... 46

Writing Images to a CD .................................................. 48
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Printing Multiple Images on One Sheet of Paper 
(Index Printing) ...............................................................49

Chapter 3 High-Level Functions....................... 50
Comparing Multiple Images ............................................51

Listing Images by Folder Level .......................................52

Viewing Shooting Information for an Image....................53

Changing the Size and Type of an Image and Saving ...54

Exporting Shooting Information ......................................55

Exporting Movies ............................................................56

Extracting Still Images from a Movie ..............................58

Organizing Images Using High-Level Functions.............60
Setting Keywords in Images ........................................60
Entering Comments into Images .................................60
Saving Multiple Images with New File Names.............61
Classifying Images by Shot Date.................................62

Searching for Images......................................................63

Performing Advanced Editing .........................................64
Adjusting the Color of an Image in RGB......................64
Adjusting the Brightness Level ....................................65
Adjusting the Tone Curve ............................................65
Unsharpening an Image ..............................................66
Transferring Images to Other Image Editing Software 67
Merging Images to Create Panorama Images.............67

Adding Sound to Images/Playing Back .......................... 69
Adding Sound to Images ............................................. 69
Playing Back Sound .................................................... 69

Printing Using Other Printing Software........................... 70

Chapter 4 Preferences....................................... 71
Preferences .................................................................... 72

General Settings.......................................................... 72
Selection Settings........................................................ 73
Rotation Settings ......................................................... 73
Printing Settings .......................................................... 74
Shooting Information Settings ..................................... 74
Themes Settings.......................................................... 75

Showing/Hiding Task Buttons......................................... 75

Chapter 5 Using Images on the Internet .......... 76
Using CANON iMAGE GATEWAY ................................. 77

Membership Registration............................................. 77
Displaying the Top Page of CANON iMAGE 
GATEWAY................................................................... 77
Uploading Images in a CANON iMAGE GATEWAY 
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Displaying a Registered CANON iMAGE GATEWAY 
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Reference............................................................. 79
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Basic Operation
Starting up ZB............................................................  7
Downloading an Image to Your Computer ................  7

Downloading Images Using Your Card Reader............  9
Viewing an Image ....................................................  11

View Images as Thumbnails in the Main Window ...... 11
Enlarging a Selected Folder ................................... 12
Changing the Display Magnification ....................... 13

Enlarging and Viewing Images One at a Time ........... 13
Displaying an Image Across the Whole Window (Full 
View Display).......................................................... 14

Playing Movies ........................................................... 15
Rewriting Images to a Memory Card .......................... 16

Printing an Image ....................................................  17
Printing One Image on One Sheet of Paper............... 17
Printing an Image Using Easy-PhotoPrint EX ............ 18

Exiting ZB ................................................................  20CO
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Starting up ZB
Double-click the desktop icon.

ZB starts up and the main window appears.

Double-click

Main window

Downloading an Image to Your Computer
Connect the camera and computer with the cable provided and 
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility” 
from ZB and use.

1 Select the save destination for the images.

When creating a folder, refer to p.26.

Click to display the [All 
Folders] tab sheet

Click
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2 Start up EOS Utility.
Click the buttons [Acquire & Camera Settings]  [Connect to 
EOS Camera].

EOS Utility starts up.

EOS Utility

3 Connect your camera and computer and turn the 
camera on.

Connect the camera and your computer with the interface cable 
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and 
computer, refer to the “EOS Utility Instruction Manual” (PDF 
electronic manual).

When the dialog box below appears, select [Canon EOS Utility] 
and then click the [OK] button.
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4 Download images.

Downloading of images begins.
The downloaded images are saved in the folder selected in step 
1 and are displayed in the main window of ZB.
The downloaded images are sorted into folders by date and 
saved.
Click the EOS Utility [Quit] button to exit EOS Utility and turn the 
camera’s power switch to < OFF >.

Click

Using EOS Utility to download images makes it easier to organize your 
images as they are downloaded, sorted and saved into folders by date.

Advantages of using EOS Utility to download images

You can also download images to the computer using a third-party card 
reader.

1 Select the save destination for the images (p.7).

2 Load the memory card into the card reader.

When the dialog box below appears, select [using Canon 
ZoomBrowser EX] and then click the [OK] button. ZB starts up.

Proceed to step 4.

Downloading Images Using Your Card Reader
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3 Start up ZB.
Click the buttons [Acquire & Camera Settings]  [Acquire 
Images from Memory Card].

Download images window appears.

4 Download images.

Downloading of images begins.
The downloaded images are saved in the folder selected in step 
1 and are displayed in the main window of ZB.
The downloaded images are sorted into folders by date and 
saved.
Click the [Exit] button to exit Download images window.

Click

Download images window

Using ZB to download images makes it easier to organize your images 
as they are downloaded, sorted and saved into folders by date.

Advantages of using ZB to download images
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Viewing an Image
Images and movies downloaded to your computer are displayed as a 
thumbnails list in the main window. You can double-click a thumbnail to 
open the viewer window and display an image at a larger size or play a 
movie.

To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.

View Images as Thumbnails in the Main Window

Main window
Click to select the image

Display thumbnails of all the 
images inside the folder selected 
in the folder area on the left

Move the cursor over the image with the 
mouse and you can check images that 
are displayed in the simple display 
window (mouse over window).
To deactivate simple display, click on 
[ ] on the top of the window, select 
[Show Mouse Over Windows] from the 
menu and remove the check mark.

Simple Display Function

For a list of the main window functions, refer to p.82.

Simple display window
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Enlarging a Selected Folder
Images downloaded to your computer are displayed in folders in the 
main window. Double-click on an empty part of the folder you want to 
enlarge to zoom in and display the images inside that folder at a larger 
size.

Enlarge folders.

The folder you have double-clicked zooms in.

Double-
click on an 
empty part 
of the folder

To revert to the folder size before enlarging, click [ ] on the top 
of the window.

You can change the speed at which a folder zooms in (p.72).
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Changing the Display Magnification
If you have many images inside a folder and they are small and difficult 
to see, you can change the display magnification and display the 
images at a larger size.

Change the display magnification.

You can also change the display magnification by clicking [ ] 
or [ ].
The display magnification of the images changes.

The [Navigator] window appears and you can check and move 
the enlargement display position.
You can also move the enlargement display position by clicking 
[ ] on the top of the window and dragging over the window.
To return to full view, click [ ] on the top of the window.

Drag to the right

Navigator window

Enlargement 
display position
Drag to move the 
enlargement 
display position

1 Double-click an image to enlarge.

The viewer window appears.

Enlarging and Viewing Images One at a Time

Double-click
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2 Click [ ] or [ ] to switch to the image you want to 
display.

The shooting information is displayed by clicking [ ] on the 
top of the window.
To exit the viewer window, click [ ] on the top right of the 
window.

Viewer window

The [Display Original Image] button appears at the bottom of the 
window. Click this button to display the processed image.

When you display RAW images in the viewer window

For a list of viewer window functions, refer to p.85.

Displaying an Image Across the Whole Window (Full View Display)
Double-click on the image you want to display 
across the whole window.

You can also display the image across the whole window by 
clicking [ ] on the top of the window.
The image is enlarged and displayed across the whole window.

To return to the viewer window, click on the window or press the 
< Esc > key on the keyboard.

Double-click
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[ ] icon in the thumbnail image frame in the main window.

In the main window, double-click a movie (image 
marked with the [ ] icon).

A viewer window appears and the movie starts playing.

Playing Movies

Double-click

Playback stops automatically when the movie ends.
To play the same movie again, click the [ ] button.
You can save the currently displayed scene as a still image by 
clicking the [Save as still image] button.
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computer to a memory card and then play them back on the camera. 
Use a third-party card reader to rewrite your images or movies to a 
memory card.

1 Insert a memory card that has been formatted on the 
camera into the card reader.

2 Select the image or movie you want to rewrite.

3 Rewrite the image or movie.
Click the buttons [Acquire & Camera Setting]  [Transfer Images 
to Memory Card].

Rewriting Images to a Memory Card 4 Select the destination memory card and click the 
[OK] button.

A confirmation window appears.

5 Click the [Transfer] button in the confirmation 
window.

Image or movie exporting begins.

You cannot rewrite MOV movies that have undergone movie 
editing (p.38) or movie exporting (p.56) to a memory card.
AVI movies cannot be rewritten to a memory card.
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Printing an Image
This section explains how to print one image on one sheet of paper, and 
how to print using Easy-PhotoPrint EX.

You can print one image on one sheet of paper.

1 Select the image to be printed.

To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.
You can select all the images inside a folder by clicking on an 
empty part of the folder.

Printing One Image on One Sheet of Paper

Click

2 Display the print settings window.
Click the buttons [Print & Email]  [Photo Print].

The [Photo Print] window appears.

3 Set the paper size and other settings, and then click 
the [Print] button.

Printing begins.

Photo Print window

For a list of photo print window functions, refer to p.87.
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EX (hereinafter, “EPP EX”) software for Canon printers, you can start up 
EPP EX from within ZB and easily perform high-quality photo printing. 
To perform this printing, it is necessary to first install EPP EX version 1.0 
or later on your computer.
Also, Easy-PhotoPrint users can select [Easy-PhotoPrint] in step 2 and 
print following the same steps.

1 Select the image to be printed.

To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.
You can select all the images inside a folder by clicking on an 
empty part of the folder.

Printing an Image Using Easy-PhotoPrint EX

Click

2 Start up EPP EX.
Click the buttons [Print & Email]  [Easy-PhotoPrint EX Photo 
Print].

EPP EX starts up.

3 Specify the number of copies to be printed and then 
click [Select Paper].
Easy-PhotoPrint EX

Click to increase the number of copies to be printed
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4 Specify the paper size and then click [Layout/Print]. 5 Specify the layout and then click the [Print] button.

Printing begins.

You can also create an album with EPP EX by clicking the [Create 
and Print Album] button in the menu in step 2.
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Exiting ZB
In the main window, select the [File] menu  [Exit].

ZB exits.
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Advanced Operation
Checking/Sorting Images ......................................... 22

Enlarging and Checking Images One at a Time........  22
Enlarging a Specific Part of an Image ...................  23

Sorting Images...........................................................  23
Arranging Images in the Main Window .................... 24

Extracting Images You Want to Display (Filter 
Display) .................................................................  24

Efficiently Checking/Sorting Images......................... 25
Organizing Images ................................................... 26

Creating a Folder for Saving Images.........................  26
Moving Images ..........................................................  27

Moving Images in Folders......................................  27
Changing Image File Names or Folder Names........  28
Deleting Images.........................................................  28

Deleting Folders.....................................................  29
Registering Frequently-Used Folders as Favorite 
Folders ....................................................................  29

Deleting Favorite Folders.......................................  30
Editing an Image ...................................................... 31

Automatic Adjustment Using ZB................................  31
Adjusting Brightness, Color and Contrast..................  33
Trimming an Image....................................................  34
Inserting Text into Images .........................................  35
Adjusting Sharpness..................................................  36
Correcting Red-Eye Automatically.............................  37

Correcting Red-Eye Manually................................  37

Editing Movies .........................................................  38
Cutting Movies............................................................ 41

Utilizing Your Images...............................................  43
Viewing Images as a Slide Show ............................... 43
Sending an Image by E-Mail ...................................... 44
Creating Wallpaper from an Image............................. 45
Creating a Screen Saver from an Image.................... 46
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Checking/Sorting Images
You can enlarge images one at a time from a list in the main window and 
check what they look like in detail, and sort them into one of three 
groups with [ ] (ratings).

1 Double-click on the image on the top left of the main 
window.

The viewer window appears.

Enlarging and Checking Images One at a Time

Double-click

2 Click [ ] or [ ] to switch to the image you want to 
display.

The shooting information is displayed by clicking [ ] on the 
top of the window.
To exit the viewer window, click [ ] on the top right of the 
window.
When checking RAW images, always click on the [Display 
Original Image] button and check the processed images.

Viewer window

Select multiple images in the main window (p.11) and then click on 
[ ] on the top left of the main window (p.82) to display only 
the selected images in the viewer window.

To display only selected images in the viewer window

For a list of viewer window functions, refer to p.85.
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Enlarging a Specific Part of an Image

1 Enlarge an image.

You can also change the display magnification by clicking [ ] 
or [ ].
The image enlarges and the [Navigator] window appears.

2 Display the part of the image you want to check.
Drag the enlargement display position in the [Navigator] window 
and display the part of the image you want to check.

You can also move the enlargement display position by clicking 
[ ] on the top left of the window and dragging over the window.
To return to full view, click [ ] on the top left of the window.

Drag to the right

Navigator window

Enlargement 
display position
Drag to move the 
enlargement 
display position

Enlargement ratio

RAW images cannot be enlarged before they are processed. By clicking 
the [Display Original Image] button on the bottom of the window, the 
image is processed and it can be enlarged.

Enlarging RAW images

You can sort images into one of three groups by attaching [ ] (ratings) 
according to photo subject or theme. Please note that [ ] is 
automatically attached to images shot with your camera.

Increase or decrease a rating.

Sorting Images

Click to increase
Click to decrease
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Arranging Images in the Main Window
You can arrange images in order of how many [ ] you have attached 
to it (ratings), or according to the image’s shooting date and time.

Select the [View] menu  [Sort by]  desired item.

The images are arranged in the order according to the selected item.
Sort item Description

Star Rating Images are arranged in the order of the least number of [ ].
Name Image file names are arranged in the order of 0 – 9  a – z.
Shooting Date Images are arranged in the order of most recently shot.
Modification Date Images are arranged in the order of most recently updated.
Type Images are arranged in the order of BMP images  

RAW images  JPEG images  MOV movies  TIFF 
images.

Ascending Images are arranged from top to bottom in order of sorting criteria.
Descending Images are arranged from bottom to top in order of sorting criteria.

Extracting Images You Want to Display (Filter 
Display)
You can extract images displayed in the main window by the number of 
[ ] you have attached to them (ratings).

1 Click the [ ] button.

The extract function appears.

2 Checkmark the number of [ ] you want to extract 
and display.

Only the images with the number of [ ] you have checkmarked 
are displayed in the main window.
To exit the extract display, click the [ ] button again.
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Efficiently Checking/Sorting Images
With Preview Mode that displays images as thumbnails and as single 
images in the same window, you can sort images by the number of 
[ ] while checking efficiently. You can also simultaneously check 
shooting information for images.

1 Enable Preview Mode.

The main window display switches to Preview Mode.
Click

2 Click the [ ] or the [ ] button 
to switch to the image you want to check, and then 
sort with the number of [ ].

You can also click on the image in the thumbnail image display 
area to display the image enlarged in the center of the window.
When checking RAW images, always click on the [Display Original 
Image] button in the viewer window and check the processed images.
When you have selected a movie, the first frame shot is 
displayed in the center. For playing movies, refer to p.15.

The selected image is enlarged in the center of the window

Thumbnail image display area

Click to increase or decrease

You can double-click the folder icon to display the images in the folder in 
the thumbnail image display area.

When a folder icon appears in the thumbnail image display area

For a list of Preview Mode functions, refer to p.84.
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Organizing Images
This section explains functions that are useful for organizing images 
such as creating new folders for saving sorted images, moving and 
copying images and deleting unwanted images.

You can create a folder to save sorted images.

1 In the folder area, select the location where the new 
folder is to be created.

Creating a Folder for Saving Images

2 Select the [File] menu  [New Folder].

The [New Folder] dialog box appears.

3 Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.
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according to shot date or theme.

Drag the image to be moved or copied.
To move:Drag the image and release when the image is in the 

destination folder.
To copy: Drag the image while holding down the < Ctrl > key and 

release when the image is in the destination folder.

The image is moved or copied to the folder it was dragged to.

Moving Images

Drag an image in the main window to a folder in the folder area on the 
bottom left of the window in the same way as described above to move 
or copy the image.

Moving images to a folder in the folder area

Moving Images in Folders
You can move or copy folders that contain images, and organize images 
in folders.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the 

destination folder.
To copy: Drag the folder while holding down the < Ctrl > key and 

release when the folder is in the destination folder.

The folder is moved or copied to the folder it was dragged to.

Drag a folder in the main window to a folder in the folder area on the 
bottom left of the window in the same way as described above to move 
or copy a folder.

Moving folders in the folder area
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the main window, or select the folder whose name 
you want to change in the folder area.

2 Select the [File] menu  [Rename].

The [Rename Image] or [Rename Folder] dialog box appears.

3 Enter the file name or folder name of the image and 
then click the [OK] button.

The file name or folder name changes to the new name.

Changing Image File Names or Folder Names

You can also change the file names in the [Properties] window 
(p.53) or the image display area in Preview Mode (p.84).
You can also change the folder names in the [Properties] window 
(p.53).

Please take care as deleted images cannot be recovered.

1 Select the unwanted image in the main window.

2 Click [Delete].

The [Confirm File Delete] dialog box appears.

3 Click the [Yes] button.
The image is moved to the [Recycle Bin] and is deleted from ZB.
Right-click [Recycle Bin] on the desktop and select [Empty 
Recycle Bin] from the menu that appears to delete the image 
from your computer.

Deleting Images

Click
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Deleting Folders
Deleted folders cannot be recovered. Please take care as all images 
inside folders are also deleted.

1 In the folder area, select the folder you want to 
delete.

2 Select the [File] menu  [Delete].

The [Confirm File Delete] window appears.

3 Click the [Yes] button.
The folder is moved to the [Recycle Bin] and is deleted from ZB.
Right-click [Recycle Bin] on the desktop and select [Empty 
Recycle Bin] from the menu that appears to delete the folder 
from your computer.

You can register shortcuts for frequently-used folders in the [Favorite 
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [My Pictures] folder is registered as a 
favorite folder by default, the folder icon appears as [ ].

1 Select the folder you want to register.

2 Click the [Add to Favorites] button.
The folder icon changes to [ ] and is registered as a favorite 
folder.

Registering Frequently-Used Folders as Favorite Folders
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3 Select the [Favorite Folders] tab sheet.

4 Select the registered folder to display the images 
inside the folder.

The images inside the folder appear.

Click

Any changes done to images inside registered folders will be applied to 
the original images. Therefore, please be aware that by editing or 
deleting images inside registered folders, you are in fact editing or 
deleting the original images.

If you have edited or deleted images in folders you have 
registered as favorites

Deleting Favorite Folders
If you no longer need a folder you have registered in the [Favorite 
Folders] tab sheet, you can delete it from this tab sheet.
Please note that as registered folders are shortcuts, the original folder 
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder 
you want to delete and then click the [Remove] 
button.

The folder is deleted.
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Editing an Image
If the brightness or color of images is different from what you visualized 
when you shot the photo, you can adjust an image using the editing 
functions to bring them closer to what you visualized.
This section explains about automatic adjustment of images, adjustment 
of brightness, saturation and contrast, trimming images, inserting text 
into images, adjustment of sharpness, red-eye correction, and cutting 
movies.
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those 
described above.

The brightness and colors, etc. of the image are automatically adjusted.

You can edit RAW images in Digital Photo Professional (hereinafter, 
“DPP”). Select the RAW image in the Main Window and click the 
buttons [Edit]  [Digital Photo Professional Process RAW images], 
which will start up DPP. For detailed instructions on using DPP, 
refer to “Digital Photo Professional Instruction Manual” (PDF 
electronic manual).

1 Select the image you want to edit.

2 Click the buttons [Edit]  [Edit Image].

The [Edit Image] window appears.

Automatic Adjustment Using ZB

3 Select the buttons [Auto Adjustment]  [Finish].

The [Auto Adjustment] window appears.

Edit Image window
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4 Click the [Auto Adjust Image] button.

The image is adjusted.

5 Enlarge the window and check the adjustments.

In enlarged view, the [Navigator] window appears and you can 
check and move the enlargement display position.

Auto Adjustment window

Drag right to enlarge
Fits the image to the window size

Moves the enlargement display position
Zooms in/Zooms out

To revert to full view, click [ ] on the bottom left of the window.

6 Click the [Save As] button and save as a separate 
image.

The [Save As] window appears.

7 Specify the save destination and then click the 
[Save] button.

The edited image is saved as a separate image from the original 
image.

Window in enlarged display

Enlargement display position
Drag to move the enlargement display position
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1 Select the image you want to edit and display the 
[Edit Image] window (p.31).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 Adjust the image.

Move the slider to the right to make the [Brightness] of an image 
appear brighter, the [Saturation] to appear more vivid and the 
[Contrast] stronger. Move the slider to the left to make the image 
appear darker, and the saturation and the contrast weaker.
The image is adjusted.

Adjusting Brightness, Color and Contrast

Drag to the left or right to adjust
Color/Brightness Adjustment window

4 Enlarge the window and check the adjustments 
(p.32).

5 Click the [Save As] button and save as a separate 
image (p.32).
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composition of an image where an image shot horizontally becomes 
vertical.

1 Select the image you want to edit and display the 
[Edit Image] window (p.31).

2 Select [Trim] and then click the [Finish] button.
The [Trim Image] window appears.

3 Drag the trimming range.

The trimming range can be moved by dragging.
You can change the trimming range by dragging the four corners 
and the four sides of the trimming range.

Trimming an Image

Trim Image window

Drag

4 Click the [Trim Image] button.

The image is trimmed.

5 Click the [Save As] button and save as a separate 
image (p.32).
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image as text.

1 Select the image you want to edit and display the 
[Edit Image] window (p.31).

2 Select [Insert Text] and then click the [Finish] button.
The [Insert Text] window appears.

3 Drag the range for inserting text.

The text insertion range can be moved by dragging.
You can change the text insertion range by dragging the four 
corners and the four sides of the text insertion range.

Inserting Text into Images

Insert Text window

Drag

4 Using the keyboard, enter the text you want to insert.

The text you enter appears in the window.

5 Click the [Save As] button and save as a separate 
image (p.32).
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1 Select the image you want to edit and display the 
[Edit Image] window (p.31).

2 Select [Sharpness] and then click the [Finish] button.
The [Sharpness] window appears.

3 Adjust the image.

Move the slider to the right to make an image harder and to the 
left to make an image softer.
The image is adjusted.

Adjusting Sharpness

Sharpness window
Drag right to adjust

4 Enlarge the window and check the adjustments 
(p.32).

5 Click the [Save As] button and save as a separate 
image (p.32).
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photograph people using a flash.

1 Select the image you want to edit and display the 
[Edit Image] window (p.31).

2 Select [Red Eye Correction] and then click the 
[Finish] button.

The [Red Eye Correction] window appears.

3 Click the [Start] button.

The image is corrected.

4 Click the [Save As] button and save as a separate 
image (p.32).

Correcting Red-Eye Automatically

Red Eye Correction window

Correcting Red-Eye Manually
You can manually correct red-eye that cannot be corrected automatically.

1 Display the [Red Eye Correction] window (Description 
on the left).

2 Enlarge the image (p.32).

3 Select [Manual Mode] and then click [ ].

4 Click on the places in the image you want to correct.
When you move the mouse cursor on the places to be corrected, 
[ ] is displayed.

The image is corrected.

5 Click the [Save As] button and save as a separate 
image (p.32).

Click
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Editing Movies
You can edit the movies you have downloaded to your computer in a 
number of ways, including joining movies together and adding special 
effects such as titles and background music. 

However, once you have edited movies using these functions, 
you cannot play them back on the camera.
These functions are compatible with MOV movies shot at all 
frame rates* with an EOS DIGITAL camera. However, the frame 
rate of MOV movies after edition with these functions is 30 fps.
*Frame rate: number of frames recorded per second

1 Select the movie.

2 Click the buttons [Edit]  [Edit Movie].

The movie editing window appears.

3 Click the button on the left to select an editing task, 
and then edit the movie.

Shows detailed instructionsSelect the editing task

Guidance Storyboard area*

*This shows thumbnails of the selected movies. Movies are joined 
together sequentially starting from the leftmost movie.
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Storyboard area functions

[Arrange] window functions

Play movies
Rearrange the order of the selected movies

Show information for the selected movie
Movie editing function preferences

Remove the selected movie from the storyboard area

Transition box (icon for the special effect used in the transition 
between joined movies)

Rearrange the order of the selected movies

Set rotation or mirroring for the selected movie

Set the playback range for the movie 
(playback start and end)*

*When a still image is selected in the storyboard area, you can 
select the display period for the still image.

[Apply Effect] window functions

Convert the selected movie to 
sepia tone or monochrome

*Select the transition box in the storyboard area and then click the 
[Transition Effect] button to set the effect used.

Add text to the selected movie
Enlarge part of the 
selected movie

Set the effect used in the transition between movies (transition box)*

When you add to the storyboard area an image with recorded audio 
that has been shot with a EOS-1D series camera, the audio is not 
automatically attached. Add the audio file in the [Set Audio] window 
on the next page.
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[Set Audio] window functions

4 Click the [Save] button on the left.

The [Save] window appears.

Adjust the audio volume for the selected movie and set 
“Fade-in” (gradually increasing volume) and “Fade-out” 
(gradually decreasing volume)

*You can add an MP3 or WAV audio file as background music 
(BGM) or as an effects tone. When you add audio to a movie in this 
window, a bar showing the duration of the audio file appears under 
the movie’s thumbnail in the storyboard area.

Add an audio file to the selected movie* 5 Specify the required settings (save destination, etc.) 
and then click the [Save] button.

When [MOV (H.264)] is selected in the [Specify a save image 
type] list box, clicking the [Advanced Settings] button allows you 
to specify the [Image Size] and [Audio] settings. The [Audio] 
sampling frequency for edited MOV movies is fixed at 44.1 kHz. 
When [AVI (MotionJPEG)] is selected, you can specify the 
[Image Size], [Frame Rate] and [Audio] settings.
The edited movie is saved.

6 Click the [Exit] button on the left.

Automatically set the optimal size 
and frame rate for saved movies

Enter the file name 
Select the folder in which the 
movie will be saved

Set the format of the saved movie
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When [MOV (H.264)] is selected in the [Specify a save image 
type] list box in the window in step 5, the movie durations that can 
be saved are as shown below.

If you attempt to save a movie that is longer than the times shown 
above, a message appears. When this happens, shorten the 
movie or reduce the image size.
Saving movies may take some time. Saving movies takes a 
particularly long time when [MOV (H.264)] is selected in the 
[Specify a save image type] list box.
E.g.)Saving a 1-minute movie with an image size of 1920 × 1080 

takes about 10 minutes depending on the system 
requirements (p.81).
Time taken to save varies largely with factors including 
computer performance and image size, and may take an 
even longer time.

Image size Movie durations that can be saved

1920 × 1080 Under 10 min.

1280 × 720 Under 20 min.

640 × 480 Under 30 min.

320 × 240 Under 60 min.

You can cut any favorite scene from a movie you have shot.

1 Double-click the movie you want to play.

The viewer window appears.

2 Click the [Cut Movie] button.

The [Cut Movie] window appears.

Cutting Movies

Double-click

CO
PY



42

1Basic 
Operation

Reference

Introduction

2Advanced 
Operation

4
5Using the

Internet

3High-Level 
Functions

Index

Contents 
Lookup

Preferences

Table of 
Contents

3 Click the [ ] button.

The movie begins to play.

4 Click the [ ] button at the position you want to set 
as the start point, and click the [ ] button at the 
position you want to set as the end point.

The movie is cut.

Cut Movie window 5 Click the [Save] button.

The [Save As] window appears.

6 Specify the file name and save destination and then 
click the [Save] button.

The cut movie is saved as a separate movie from the original 
movie.
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Utilizing Your Images
You can view your images as a slide show, send them in an e-mail or 
use them as wallpaper or screen savers for your computer.

You can display selected images in full screen and switch between them 
as a slide show.

1 Select images.

2 Click [Slide Show].

The [View as a Slide Show] window appears.

Viewing Images as a Slide Show

3 Set the slide show style and then click the [Finish] 
button.

The Slide Show window appears and the slide show begins.

View as a Slide Show window
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*1 The image is selected. When the slide show ends and returns to 
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and 
returns to the main window, the print dialog box is displayed.
When all the images have been displayed, the Slide Show 
window closes and returns to the main window.
To end the slide show half-way through, click [ ].

Slide Show window

File name Rating setting
Selects the image*1

Prints the image*2

Switches to the previous image
Pauses the slide show
Switches to the next image
Ends the slide show

You can attach a selected image to an e-mail and send it.
The attached image to be sent is a copy of the original image and 
therefore the original image remains unaffected on your computer.
Please note that the e-mail software for attaching and sending an image 
selected in ZB is MAPI-compatible software. Please consult the 
Instruction Manual for your e-mail software for settings related to MAPI.

1 Select an image.

2 Click the buttons [Print & Email]  [Email Images].

The [Email Images] window appears.

Sending an Image by E-Mail
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3 Select [Using the recommended settings.], and then 
click the [Attach to Email] button.

The e-mail software starts up and the image is attached to an e-
mail.
Enter the address and a message and send the e-mail.

Email Images window You can make a selected image wallpaper for your computer.
The bitmap image for the wallpaper (extension “.BMP”) is created using 
a copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export as a Wallpaper].

The [Export as a Wallpaper] window appears.

Creating Wallpaper from an Image
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3 Specify the layout and the save destination for the 
wallpaper, and then click the [Finish] button.

The image you selected for your wallpaper is applied as 
wallpaper.
The image you selected for your wallpaper is saved in the 
specified folder.

Export as a Wallpaper window

1 On the desktop, right-click with the mouse and in the menu that 
appears, select [Properties].

2 Select the [Desktop] tab sheet.
3 Select the file to become the wallpaper and then click the [OK] button.

To revert to the original wallpaper

You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SCR”) is created using a 
copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export as a Screen 
Saver].

The [Export as a Screen Saver] window appears.

Creating a Screen Saver from an Image
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3 Checkmark [Include images in the screen saver] and 
click the [Finish] button.

The data for the screen saver is saved in the specified folder.

Export as a Screen Saver window

4 Specify the saved screen saver on your computer.
On the desktop, right-click with the mouse and in the menu that 
appears, select [Properties]. Display the [Screen Saver] tab 
sheet in the [Display Properties] dialog box.

Applies the selected screen saver data
Select the saved screen saver data

When you checkmark [Include images in the screen saver] in step 3, the 
original image is copied to create the data for the screen saver. This 
means that even if the original image is deleted or the file name is 
changed, it does not affect the screen saver. However, if you remove the 
check mark, the data is created using the original image, and if the 
original image is deleted or the file name is changed, the screen saver 
will not work properly.

About the [Include images in the screen saver] checkbox

CO
PY



48

1Basic 
Operation

Reference

Introduction

2Advanced 
Operation

4
5Using the

Internet

3High-Level 
Functions

Index

Contents 
Lookup

Preferences

Table of 
Contents

Writing Images to a CD
You can write selected images to a CD.
This function is only compatible with a computer that has Windows XP 
or Windows Vista preinstalled and is equipped with a standard CD-R/
RW drive.

1 Insert a CD-R/RW disk in the CD-R/RW drive.
When the dialog box below appears, select the [Cancel] to close 
the dialog box.

2 Select the images you want to write to the CD.

3 Click the buttons [Export]  [Backup to CD].

The [Backup to CD] window appears.

4 Specify the settings for writing to the CD-R/RW disk 
and then click the [Finish] button.

Writing to the CD-R/RW begins.

Backup to CD window
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Printing Multiple Images on One Sheet of Paper (Index Printing)
You can arrange multiple images in index format and print them on one 
sheet of paper.

1 Select the images.

2 Click the buttons [Print & Email]  [Index Print].

The [Index Print] window appears.

3 Specify settings such as the paper type and the 
number of prints, and then click the [Print] button.

Printing begins.

Print preview
Index Print window

For a list of index print window functions, refer to p.88.
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Comparing Multiple Images
To compare multiple images, you can split the viewer window into two, 
three or four and display multiple images at the same time.
You can also align the display position of enlarged images and compare.

1 In the main window, select the images you want to 
compare (p.11).

2 Click [ ] (p.82).
The viewer window appears.

3 Select the number of images you want to display at 
the same time.

The viewer window is split and the multiple images are displayed 
at the same time.

Example of display when [ ] is clicked

4 Click [Synchronize] and then enlarge the image.

The synchronize display appears and all the images are 
displayed at the same display magnification and in the same 
position.
The [Navigator] window that displays the enlargement display 
position appears and you can check and move the enlargement 
display position (p.23).
Click [Synchronize] again to cancel the synchronize display. You 
can now change the display magnification and move the 
enlargement display position for each image.
To return to full view, click [ ] on the top left of each window.
To cancel the split display, click [ ] at the top of the window.

Drag right to change the display magnification

Click
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Listing Images by Folder Level
You can switch the main window display to Scroll Mode that displays in folder 
levels and simultaneously view multiple folders and images inside the folders.
You can also set the level to which images and folders are displayed in the 
window, which makes looking for the folders and images you want easier.

1 Click the [Scroll Mode] tab sheet.

The display in the main window switches to Scroll Mode.

2 Select the [Tools] menu  [Preferences].
The [Preferences] window appears.

3 Change the depth of the folder level to be displayed.

4 Click the [OK] button.
The main window is displayed at the folder depth you set.

Folders up to the third level and images inside the folders are 
displayed in the window.
Folders at or higher than the fourth level are displayed as folder 
icons. Double-click these folders to display images and folders 
inside the folders.

Example of display when you have set the folder level setting [3]

Click Number of images inside the folder 
and number of folders

For a list of Scroll Mode window functions, refer to p.83.
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Viewing Shooting Information for an Image
1 Enable Zoom Mode (p.82) or Scroll Mode (p.83).

2 Select the image for which you want to view the 
information.

3 Click [Properties].

The [Properties] window (image information window) appears.

Properties window

In Preview Mode, the same information as the [Properties] window 
is displayed on the information display area (p.84).

CO
PY



54

1Basic 
Operation

Reference

Introduction

2Advanced 
Operation

4
5Using the

Internet

3High-Level 
Functions

Index

Contents 
Lookup

Preferences

Table of 
Contents

Changing the Size and Type of an Image and Saving
You can change the size of an image or convert it to a TIFF image 
(extension “.TIFF”) or a bitmap image (extension “.BMP”) and save it. 
Because the image is saved as a separate image, the original image 
remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export Still Images].

The [Export Still Images] window appears.

3 Specify the image size, type, file name and save 
destination, and then click the [Finish] button.

The image is saved as an image separate from the original 
image.CO
PY
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Exporting Shooting Information
You can export as a text file the shooting information recorded to the 
image.

1 Select an image.

2 Click the buttons [Export]  [Export Shooting 
Properties].

The [Export Shooting Properties] window appears.

3 Specify the export shooting information and save 
destination, and then click the [Finish] button.

The shooting information is saved as a text file (extension 
“.TXT”).CO
PY
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Exporting Movies
You can change the size or type of a movie and then export it as a 
separate file.

Once you have exported movies using this function, you cannot play 
them back on the camera.

1 Select the movie.

2 Click the buttons [Export]  [Export Movies].

The [Select the save image type] window appears.

3 Select the image type you want to save and click the 
[Next] button.

Specify the [Rotation settings] as necessary
The [Set the save image type] window appears.
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4 Set the image type you want to save and click the 
[Next] button.

When [MOV (H.264)] is selected in the [Save image type] list box 
in the window in step 3, you can only specify the [Image Size] 
and [Audio] settings. The [Audio] sampling frequency for edited 
MOV movies is fixed at 44.1 kHz. When [AVI (MotionJPEG)] is 
selected, you can specify the [Image Size], [Frame Rate], [Image 
Quality] and [Audio] settings. 
The [Specify name of file to be saved] window appears.

5 Specify the required settings (saved file name, save 
destination, etc.) and then click [Finish]. 

Movie exporting begins.

Some time is taken to export movies. For detailed information, refer 
to  on p.41.
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Extracting Still Images from a Movie
You can extract still images from a movie and save them as image files.

1 Select the movie.

2 Click the buttons [Export]  [Extract frames from a 
movie].

The [Set extraction method] window appears.

3 Set the extraction method and click the [Next] 
button.

[Extract all frames]
This option extracts all the frames in a movie as still images.
[Specify an interval and extract frames]
This option extracts still images from a movie at intervals of a set 
number of frames or seconds.
[Specify the number of copies and extract frames]
This option extracts a specified number of still images from the 
frames of a movie. The interval at which each of the specified 
number of images is extracted is calculated evenly across the 
movie’s number of frames.
[Extract a specified image]
This option extracts a still image of a scene of your choice during 
movie playback.
The [Preview image] window appears.
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4 Check the extracted images and click the [Next] 
button.

When [Extract a specified image] is selected in the window in 
step 3, you can play the movie in the upper section of the window 
and extract an image by clicking the [Add] button when you reach 
a scene you like.

The [Set up save] window appears.

Remove the check mark from the images 
before and after the selected image

Resize the thumbnails
Playback/pause, stop, frame back, 
frame forward, volume adjustment, 
half-speed playback, double-speed 
playback

Save the images with check marks
Add/remove all the check marks

Rotate all the images

5 Specify the required settings (save destination, etc.) 
and then click the [Finish] button. 

Still image extraction begins.CO
PY
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Organizing Images Using High-Level Functions
You can organize images using high-level functions such as setting 
keywords and entering comments, renaming multiple files in a single 
operation and classifying images by shot year/month/date, all of which 
are useful when organizing your images.

You can set keywords to identify images. The set keywords are also 
useful when searching for images (p.63).

1 Display the [Properties] window (p.53).

2 Click the [ ] button in [Keywords] and then click 
the [View/Modify Keywords].

The [View/Modify Keywords] dialog box appears.

3 Select the keyword(s) and then click the [OK] button.

The keyword is set in the image.

Setting Keywords in Images

You can enter information relating to images as comments. The entered 
comments are also useful when searching for images (p.63).

1 Display the [Properties] window (p.53).

2 Click the [ ] button in [Comment].
A field for entering comments is displayed.

3 Enter text and then press the < Enter > key on the 
keyboard.

The entered text is saved in the image.

Entering Comments into Images
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single operation.

1 Select all the images you want to save with new file 
names (p.11).

2 Click the buttons [View & Classify]  [Rename 
Multiple Files].

The [Rename Multiple Files] window appears.

Saving Multiple Images with New File Names 3 Checkmark [Make copies of files], enter the file name 
and then click the [Finish] button.

Images separate from the original images are saved with the new 
names.

In step 3, if you remove the check mark from [Make copies of files] 
in the window, please be aware that the file name for all the selected 
images including the original images changes.
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1 Select all the images to be classified (p.11).

2 Click the buttons [View & Classify]  [Classify into 
Folder].

The [Classify into Folder] window appears.

Classifying Images by Shot Date

Settings for Folder Structure

3 Specify the folder structure and save destination, 
and then click the [Finish] button.

Images are classified by shot date.

Setting Item Description
YearMonthDate Classifies images by creating a first-level folder 

according to shot year/month/date.
Year\YearMonthDate Classifies images by creating a second-level folder 

for the shot year, and the month and date.
Year\Month\
YearMonthDate

Classifies images by creating a third-level folder 
for the shot year, the month, and the date.
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Searching for Images
You can search for images by ratings (p.23), shot date, update, 
comments (p.60) and keywords (p.60).

1 Click the buttons [View & Classify]  [Search].

The [Search] window appears.

2 Specify the search criteria and then click the [Next] 
button.

The search begins and the images that match the criteria are displayed.

3 Click the [Finish] button to close the search results 
window.

The display returns to the main window.

4 Check the searched images in the main window.
The searched images are displayed as [Search Results] in the 
folder area in the main window. If you select this folder, the 
searched images are displayed.

The images inside the [Search Results] folder are stored until 
you either perform another search or exit ZB.
Any work you do on images inside the [Search Results] folder will 
be applied to all the original images. Therefore, please be aware 
that if you edit or delete images inside the [Search Results] 
folders, the original images will be edited or deleted also.

You can click the [ ] button in the main window and display 
the [Search] window.
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Performing Advanced Editing
This section explains image editing using high-level functions based on 
the assumption that you are familiar with handling standard image 
editing software. 
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.

You can adjust the color of an image in RGB (red, green, blue).

You can edit RAW images in Digital Photo Professional (hereinafter, 
“DPP”). Select the RAW image in the Main Window and click the 
buttons [Edit]  [Digital Photo Professional Process RAW images], 
which will start up DPP. For detailed instructions on using DPP, 
refer to “Digital Photo Professional Instruction Manual” (PDF 
electronic manual).

1 Select an image and display the [Edit Image] window 
(p.31).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 From the list box, select [RGB Adjustment].

The window switches to the [RGB Adjustment] window.

Adjusting the Color of an Image in RGB

4 Adjust the image.

The image is adjusted.

5 Click the [Save As] button and save as a separate 
image (p.32).

Drag to the left or right to adjust
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1 Select an image and display the [Edit Image] window 
(p.31).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 From the list box (p.64), select [Level Adjustment].
The window switches to the [Level Adjustment] window.

4 Adjust the image.

The image is adjusted.

5 Click the [Save As] button and save as a separate 
image (p.32).

Adjusting the Brightness Level

Drag to the left or right to adjust

You can adjust the brightness, contrast and color of a specific area by 
changing the tone curve.

1 Select an image and display the [Edit Image] window 
(p.31).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.

The [Color/Brightness Adjustment] window appears.

3 From the list box (p.64), select [Tone Curve 
Adjustment].

The window switches to the [Tone Curve Adjustment] window.

Adjusting the Tone Curve
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4 Adjust the image.

The image is adjusted.
The horizontal axis shows the input level and the vertical axis 
shows the output level.
The maximum number of [ ] is 10.
To delete a [ ], either press the < Del > key on the keyboard or 
double-click on the [ ].

5 Click the [Save As] button and save as a separate 
image (p.32).

Click to add a [ ] (point)
Adjust by dragging [ ]

You can set amount, radius and threshold values and adjust sharpness.

1 Select an image and display the [Edit Image] window 
(p.31).

2 Select [Sharpness] and then click the [Finish] button.
The [Sharpness] window appears.

3 Select the [Unsharp Mask] tab sheet and adjust.

The image is adjusted.

4 Enlarge the window and check the adjustments 
(p.32).

5 Click the [Save As] button and save as a separate 
image (p.32).

Unsharpening an Image

Drag right to adjust
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1 Select an image and display the [Edit Image] window 
(p.31).

2 Select [Edit with external image editor].

3 Click the [Manage List] button and then register the 
image editing software.

Select the image editing software in the window that appears.

4 In the [Edit with external image editor] list box, select 
the registered image editing software.

5 Click the [Finish] button.
The software selected in step 4 starts up and the image selected 
in step 1 is displayed.

Transferring Images to Other Image Editing Software
You can merge up to four JPEG images to create panorama images. 
For merging images, start up the image-merging software “PhotoStitch” 
from ZB and use.

1 Select multiple images to merge (p.11).

2 Click the buttons [Edit]  [Stitch Photos].

PhotoStitch starts up and the main window appears.

Merging Images to Create Panorama Images
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3 Check the arrangement of the images to be merged 
and click the [2. Merge] tab sheet.

If the arrangement of the images to be merged is not correct, 
drag the images to rearrange them.

The window switches to the [2. Merge] tab sheet.

4 Click [Start] to merge.

The images are merged and displayed.

5 Click the [3. Save] tab sheet.
The display switches to the [3. Save] tab sheet.CO
PY
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6 Check the save range and then click [Save].

The [Save As] dialog box appears.

7 Specify the save destination and then click the 
[Save] button.

The merged images are saved.

8Select the [File] menu  [Exit].
PhotoStitch exits.

Save range
Drag [ ] to change the range

See also the Help that are displayed when you click [ ] on the 
right of the window for information on operating PhotoStitch and 
PhotoStitch functions.

Adding Sound to Images/Playing Back
You can add sound to images and play back sound which you have 
added to images with a camera that has a sound record function.

You can add WAVE sound files to images (extension “.WAV”).

You can play back sound files that are attached to images.

1 Select an image to which you want to add sound.

2 Select the [Edit] menu  [Add/Remove Sound].
The [Sound] dialog box appears.

3 Click the [Add] button and select the sound file to be 
added to the image.

Select a WAVE sound file.
The display returns to the [Sound] dialog box.

4 Click the [OK] button to close the dialog box.
The [ ] icon is displayed on images to which sound has been 
added.

1 Select an image to which a [ ] icon is attached.

2 Select the [Edit] menu  [Play Sound].
The sound is played back.

Adding Sound to Images

Playing Back SoundCO
PY
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Printing Using Other Printing Software
You can start up printing software installed on your computer from within 
ZB and print images.

1 Select an image you want to print.

2 Click the buttons [Print]  [Print Using Other 
Software].

The [Print Using Other Software] window appears.

3 Select the printing software and then click the 
[Launch] button.

The printing software starts up and the image you selected in 
step 1 is displayed.

4 Make the necessary settings in the printing software 
and print.

Printing software that is incompatible with ZB does not appear in the 
[Print Using Other Software] window and can therefore not be used to 
print.

Printing software does not appear
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Preferences
You can change any of the ZB functions in the preferences window. 
Check the settings displayed for each window before making changes.

1 Select the [Tools] menu  [Preferences].

2 Select the tab sheet to be set, make changes to the 
settings and then click the [OK] button.

You can make settings such as adjusting the minimum size of thumbnail 
images that are displayed in the main window, the speed of Zoom Mode 
(p.82), the levels of image and folder display in Scroll Mode (p.83) and 
color management. 

General Settings
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Selection Settings
You can make settings related to image rotation.

Rotation Settings
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whether to trim the image and print with no borders around the paper, or 
to print as is without trimming. 

Printing Settings
You can set the information that is displayed when you click [ ] 
(shooting information display) in the viewer window (p.85).

Shooting Information Settings
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Themes Settings
Showing/Hiding Task Buttons
You can show or hide task buttons displayed on the left of the main 
window according to your requirements. Hiding buttons you do not use 
makes operating ZB easier.

1 Select the [Tools] menu  [Customize].
The [Customize] dialog box appears.

2 Remove the check mark from the buttons you want 
to hide.

3 Click the [OK] button to apply your changes.

4 Restart ZB for the settings to be applied.
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Using Images on the Internet
Using CANON iMAGE GATEWAY ..........................  77

Membership Registration............................................ 77
Displaying the Top Page of CANON iMAGE 
GATEWAY ................................................................. 77
Uploading Images in a CANON iMAGE GATEWAY 
Album ......................................................................... 78
Displaying a Registered CANON iMAGE GATEWAY 
Album ......................................................................... 78
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Using CANON iMAGE GATEWAY
CANON iMAGE GATEWAY is a free Internet online service restricted to 
users who have purchased a Canon digital camera (no membership or 
annual fee).
To connect to CANON iMAGE GATEWAY, it is necessary to register as a 
member beforehand. Insert the EOS DIGITAL Solution Disk provided 
into your computer and perform registration in the CANON iMAGE 
GATEWAY member registration window that appears after installing the 
software that includes ZB. You can also use the following procedure to 
register as a member.
For detailed information on CANON iMAGE GATEWAY, refer to the 
CANON iMAGE GATEWAY Help.

You can register as a member of CANON iMAGE GATEWAY.
When you have finished registering, you can also change the 
connection information or add cameras.

1 Register as a member.

The settings dialog box relating to membership registration and 
connection information appears.

Membership Registration
The CANON iMAGE GATEWAY top page is displayed with the browser 
software.

2 Click the [Register] button.
The browser software starts up and the CANON iMAGE 
GATEWAY membership registration page is displayed.
Perform membership registration by following the on-screen 
instructions.
When you have finished registering, you can also change the 
connection information or add cameras.

1 Connect to the top page.

The [Enter Login Details] dialog box appears.

2 Enter your user name and password and then click 
the [OK] button.

When the connection dialog box is displayed and connection is 
completed, the browser software starts up and the top page of 
CANON iMAGE GATEWAY is displayed.

Displaying the Top Page of CANON iMAGE GATEWAY
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Online photo album. You can also show images in a registered album to 
specified people.
The images uploaded in an album are copies, so the original images 
remain unaffected on your computer.

1 Select images to be uploaded in an album.

2 Connect to CANON iMAGE GATEWAY.

The setting dialog box relating to uploading images appears.

3 Set the size, quality of the image etc. and then click 
the [Next] button.

4 Enter your user name and password and then click 
the [Upload] button.

When the connection dialog box is displayed and connection is 
completed, the browser software starts up and the CANON 
iMAGE GATEWAY album page is displayed.

5 Create a new album.
Follow the on-screen instructions to register the images you have 
selected in step 1 in a new album.

Uploading Images in a CANON iMAGE GATEWAY Album
You can display images that have been uploaded in a CANON iMAGE 
GATEWAY Online photo album with the browser software.

1 Display an album.

The [Enter Login Details] dialog box appears.

2 Enter your user name and password and then click 
the [OK] button.

When the connection dialog box is displayed and connection is 
completed, the browser software starts up and the CANON 
iMAGE GATEWAY album page is displayed.

Displaying a Registered CANON iMAGE GATEWAY Album
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Troubleshooting
If ZB is not operating correctly, refer to the items below.
Also refer to the Help from the [Help] menu or click the [?] button at the 
top of each window and refer to the Help displayed.

You cannot install the software if a user setting with privileges other 
than [Computer administrator] or [Administrator] is selected. Select a 
user setting with [Computer administrator] privileges in Windows XP 
or [Administrator] privileges in Windows Vista. For detailed 
information on selecting the user setting, refer to your computer 
User’s Manual.

ZB does not operate correctly on a computer if its system 
requirements does not meet. Use ZB on a computer with compatible 
system requirements (p.81).
Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.81), if other applications are running at 
the same time as ZB, you may not have sufficient RAM (memory). 
Exit any applications other than ZB.

Images that are not supported by ZB (p.81) do not display. There are 
various types of JPEG and TIFF images, so JPEG images other than 
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif 
compatible images may not display properly.
With initial settings, the color of images that have been shot in Adobe 
RGB appear weak. In this case, check the [General] tab sheet in 
preferences and checkmark [Adjust color of images using monitor 
profile] (p.72). Color management is performed and the color of the 
image shot with an Adobe RGB setting and the image shot with an 
sRGB setting are matched.

Installation could not be completed correctly

ZB does not work

Images do not display properly

Deleting the Software (Uninstalling)
Exit any applications before uninstalling the software.
Log in under the Computer administrator/Administrator privileges 
when uninstalling the software.
To prevent computer malfunctions, always restart your computer after 
you have uninstalled the software. Re-installing the software without 
first restarting your computer is particularly likely to result in computer 
malfunctions.

1 Select the [Start] button ([ ] button in Windows 
Vista)  [All Programs]  [Canon Utilities]  
[ZoomBrowser EX]  [ZoomBrowser EX Uninstall].

2 Proceed with the uninstallation as directed by the 
on-screen messages.

The software is uninstalled. 
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Even though the following are recommended system requirements, not 
all computer functions can be guaranteed.

*1 Compatible with 32-bit/64-bit systems for all versions except Starter 
Edition (Also compatible with Service Pack 1)

*2 Compatible with Service Pack 2/Service Pack 3
*3 .NET Framework is Microsoft software. It is installed together with ZB.
*4 Use a Core 2 Duo 2.6GHz or higher CPU and 2GB or more RAM 

when working with MOV movies. However, even if there is nothing 
wrong with a movie file, it may drop frame and not play smoothly 
during playback, depending on your computer specifications.

OS Windows Vista*1

Windows XP Professional/Home Edition*2

Computer
PC with one of the above OS preinstalled (Upgraded 
machines not supported) 
* .NET Framework 2.0 or later is required.*3

CPU*4 Windows Vista
1.3GHz Pentium or higher

Windows XP

RAM*4 Windows Vista Minimum 1GB
Windows XP Minimum 512MB

Display Screen resolution: 1024 × 768 pixels or more
Color quality: Medium (16 bit) or more

Supported Images

* “.THM” is a (thumbnail) file that is saved with the same file name as 
the movie and that includes shooting information.
When you play a movie with the camera, both the movie file and the 
“.THM” file are required.

About RAW Image Task
RAW Image Task is the RAW image editing software linked with ZB. 
RAW Image Task is not provided with ZB ver. 6.4, but if it is installed 
on your computer, it can be started up from ZB ver. 6.4 in the same 
way as from versions 6.1 and earlier.
RAW Image Task is not compatible with RAW images shot with EOS-
1D Mark IV, EOS 5D Mark II, EOS 7D, EOS 50D, and EOS REBEL 
T1i/500D.

Image type Extension

JPEG images
JPEG images shot with a Canon digital 
camera (Exif 2.2 or 2.21-compatible 
JPEG images)

.JPG, .JPEG

RAW images
RAW images shot with a EOS DIGITAL 
camera excluding EOS D6000, EOS 
D2000, EOS DCS1, EOS DCS3

.CR2
.TIF

.CRW
TIFF images Exif-compatible TIFF images .TIF, .TIFF
BMP images Bitmap images .BMP
PCD images Photo CD images .PCD

MOV movies MOV movies shot with a Canon digital 
camera .MOV + .THM*

AVI movies AVI movies shot with a Canon digital 
camera .AVI + .THM*

System Requirements
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Zoom Mode

Folder path

Display magnification (p.13)
Filter display (p.24)

Reduction display (p.13)
Enlargement display (p.13)
Cancels [ ], [ ] or [ ]
Shows/hides the image or 
folder information
Selects/deselects all the 
images or folders
Displays the folder one level 
above
Returns to the display of the 
folder before [ ] is clicked
Returns to the display of the 
folder previously displayed

Image display area

Bracketing iconProtect icon Audio recording icon

Number of selected images

RAW image iconShows/hides the task buttons and folder area

* Images in folders and folders selected here are displayed on the image display area.

Task buttons

Folder area*

Viewer window (p.85)

Properties window (p.53)
Slide show (p.43)

Image search (p.63) Deletes images (p.28)
Rotates an image

Moves the enlargement display position (p.13)

Full view (p.13)

Shows/hides 
the task buttons

Movie icon

List of Main Window Functions

CO
PY



83

1Basic 
Operation

Reference

Introduction

2Advanced 
Operation

4
5Using the

Internet

3High-Level 
Functions

Index

Contents 
Lookup

Preferences

Table of 
Contents

Scroll Mode

Folder path

Display magnification (p.13)

Filter display (p.24)
Shows/hides the image or 
folder information

Selects/deselects all the 
images or folders

Displays the folder one level 
above

Returns to the display of the 
folder before [ ] is clicked

Returns to the display of the 
folder previously displayed

Image display area

Number of selected imagesShows/hides the task buttons and folder area

* Images in folders and folders selected here are displayed on the image display area.

Task buttons

Viewer window (p.85)

Properties window (p.53)
Slide show (p.43)

Image search (p.63) Deletes images (p.28)
Rotates an image

Folder area*

Shows/hides 
the task buttons
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Preview Mode

Folder path

Filter display (p.24)

Shows/hides the image or 
folder information

Selects/deselects all the 
images or folders

Displays the folder one level 
above

Returns to the display of the 
folder before [ ] is clicked

Returns to the display of the 
folder previously displayed

Information display area

Number of selected images
Shows/hides the task buttons and folder area

*1 Images in folders and folders selected here are displayed on the thumbnail image display area.
*2 Images selected here are displayed on the image display area.

Task buttons

Viewer window (p.85)

Slide show (p.43)
Image display area

Rotates an image

Shooting information (p.53)

Thumbnail image display 
area*2

Shows/hides the information display area
Switches between images

Deletes images (p.28)
Image search (p.63)

Folder area*1

Shows/hides 
the task buttons
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List of Viewer Window Functions

Synchronize (p.51)
File name

Rating (p.23)
Full view display (p.14)

Folder path

Switches between 
images
Fit-to-window view 
(p.23)

100% (actual pixel 
size) view
Display magnification 
(p.23)

Enlargement display (p.23)

Reduction display (p.23)

Moves the enlargement display position (p.23)
Photo print window (p.87) Edits (p.31 to p.37, p.64 to p.67)

Shows/hides the AF point

Shows/hides the shooting information (p.14, p.22)

Split displays (p.51)
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List of Cut Movie Window Functions (p.41)

Displays the movie

Previous frame

Stops the movie
Plays the movie

Current position during movie play

Sets the start point for a movie cut

Next frame

Mutes
Adjusts volume

Sets the end point for a movie cut

Saves a cut movie as a separate movie
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List of Photo Print Window Functions

Trims the image

Print preview

Number of prints

Switches the printing image

Shot date and 
time printing

Printer selection and 
settings

Inserts text

Borderless printing
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List of Index Print Window Functions

Layout settings

Print preview

Switches the printing page

Print information 
settings

Printer selection and settings

Number of prints

Paper orientation
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Contents Lookup
Downloading Images to Your Computer

Download images by connecting your camera 
and computer  p.7

Download images using a card reader  p.9

Image Checking
Look through  p.11
Enlarge and view  p.13, p.22
Play a movie  p.15
Check efficiently  p.25
Compare multiple images  p.51
Check the shooting information such as shot 
date  p.53

View as a slide show  p.43

Image Printing
Print one image on one page  p.17
Print using Easy-PhotoPrint EX  p.18
Arrange multiple images on one page and print  p.49

Organizing Images
Sort by rating  p.23
Move to a different location  p.27
Move by entire folder to a different location  p.27
Change the file name  p.28
Delete  p.28
Classify by shot date  p.62
Search  p.63

Image Editing
Use automatic adjustment  p.31
Adjust brightness/darkness  p.33
Make colors more vivid  p.33
Raise the contrast  p.33
Trim parts of an image  p.34
Specify an aspect ratio that matches the size of 
the paper on which an image is to be printed  p.34

Make an image sharp  p.36
Insert text  p.35
Correct red-eye  p.37
Merge  p.67
Edit movies  p.38
Cut a favorite scene from a movie  p.41
Extract still images from movies  p.58

Utilizing Images
Attach an image to an e-mail  p.44
Make into computer wallpaper  p.45
Make into a computer screen saver  p.46
Using CANON iMAGE GATEWAY  p.77

Converting Images
Change the size  p.54
Convert to a different type  p.54
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A
Adding Sound to Images.....................................................................  69
Adjust JPEG Images.....................................................................  31, 64
Adjusting (JPEG or TIFF Image)...................................................  31, 64

Adjusting in RGB ..........................................................................  64
Adjusting the Brightness...............................................................  33
Adjusting the Brightness Level .....................................................  65
Adjusting the Contrast ..................................................................  33
Adjusting the Saturation ...............................................................  33
Adjusting the Sharpness ..............................................................  36
Adjusting the Tone Curve.............................................................  65
Automatic Adjustment ..................................................................  31
Correcting Red-eye ......................................................................  37
Unsharpening Mask .....................................................................  66

Adjusting the Brightness .....................................................................  33
Adjusting the Brightness Level............................................................  65
Adjusting the Contrast.........................................................................  33
Adjusting the Saturation......................................................................  33
Adjusting the Sharpness .....................................................................  36
Adjusting the Tone Curve ...................................................................  65
Attach an Image to an E-mail..............................................................  44
Automatic Adjustment .........................................................................  31

B
Batch Change the File Name of Images .............................................  61

C
CANON iMAGE GATEWAY................................................................  77

Displaying an Album.....................................................................  78
Membership Registration .............................................................  77
Uploading Images in an Album ....................................................  78

Change File Name..............................................................................  28
Change Folder Name..........................................................................  28
Change the Display Magnification ......................................................  13
Changing the Folder Level Settings....................................................  52
Changing the Size and Type of an Image and Saving........................  54
Checking the Shooting Information.....................................................  53
Classifying the Images by Shot Date ..................................................  62

Color Management .............................................................................. 72
Compare Multiple Images.................................................................... 51
Contrast ............................................................................................... 33
Correcting Red-eye ............................................................................. 37
Creating a Folder................................................................................. 26
Cutting a Movie.................................................................................... 41

D
Delete

Delete Folders............................................................................... 29
Delete Images............................................................................... 28
Delete the Software ...................................................................... 80

Delete Folders ..................................................................................... 29
Delete Images ..................................................................................... 28
Delete the Software (Uninstalling) ....................................................... 80
Deleting the ZB (Uninstalling).............................................................. 80
Displaying Images Shot with Adobe RGB ........................................... 80
Downloading an Image to Your Computer ............................................ 7

Downloading Images from a Camera ............................................. 7
Downloading Images from a Card Reader...................................... 9

Downloading Images ............................................................................. 7
Downloading Images from a Card Reader ............................................ 9

E
Editing.................................................................................................. 90
Editing Movies ..................................................................................... 38
Enlarge Folders ................................................................................... 12
Enlarge Images ............................................................................. 13, 23
Exiting ZB ............................................................................................ 20
Exporting Movies ................................................................................. 56
Exporting Shooting Information ........................................................... 55
Extracting Still Images from a Movie ................................................... 58

F
Favorite Folders................................................................................... 29
Full View Display ................................................................................. 14

Adjusting
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G
General Settings (Preferences) ..........................................................  72

I
Index Printing ......................................................................................  49
Insert Text ...........................................................................................  35
Inserting Comments............................................................................  60
Inserting Text into Images...................................................................  35

K
Keywords Settings ..............................................................................  60

L
Listing Images by Folder Level ...........................................................  52

M
Main Window ..................................................................................  7, 82
Merging Panorama Images.................................................................  67
Move or Copy Folders.........................................................................  27
Move or Copy Images.........................................................................  27

N
Navigator window..........................................................................  13, 23

O
Operating with EOS Utility ....................................................................  8

P
Playing a Movie...................................................................................  15
Playing Back Sound............................................................................  69
Preferences.........................................................................................  72

General Settings...........................................................................  72
Printing Settings ...........................................................................  74
Rotation Settings ..........................................................................  73
Selection Settings.........................................................................  73
Shooting Information Settings ......................................................  74
Themes Settings ..........................................................................  75

Preview Mode (Main Window) ......................................................  25, 84
Printing

Index Printing ...............................................................................  49
Printing an Image Using Easy-PhotoPrint EX ..............................  18

Printing One Image on One Sheet of Paper ................................. 17
Printing with Printing Software other than EPP EX....................... 70

Printing an Image Using Easy-PhotoPrint EX ..................................... 18
Printing One Image on One Sheet of Paper........................................ 17
Printing Settings (Preferences)............................................................ 74

R
Ratings ................................................................................................ 23
Rewriting Images to a Memory Card ................................................... 16
Rotate images ......................................................................... 82, 83, 84
Rotation Settings (Preferences) .......................................................... 73

S
Scroll Mode (Main Window)........................................................... 52, 83
Searching for Images .......................................................................... 63
Selection Settings (Preferences) ......................................................... 73
Setting a Screen Saver........................................................................ 46
Setting a Wallpaper ............................................................................. 45
Setting an Image as a Screen Saver................................................... 46
Setting an Image as Wallpaper ........................................................... 45
Shooting Information Settings (Preferences)....................................... 74
Simple Display..................................................................................... 11
Slide Show........................................................................................... 43
Starting up ZB........................................................................................ 7
Supported Images ............................................................................... 81
Synchronize Display ............................................................................ 51
System Requirements ......................................................................... 81

T
Themes Settings (Preferences)........................................................... 75
Thumbnail Display (Main Window) ...................................................... 11
Transfer Images to other Image Editing Software ............................... 67
Trimming.............................................................................................. 34
Trimming an Image.............................................................................. 34

U
Unsharpening Mask............................................................................. 66
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V
Viewer Window .......................................................................  14, 22, 85
Viewing an Image ...............................................................................  11

W
Writing Images to a CD.......................................................................  48
Writing to a CD....................................................................................  48

Z
Zoom Mode (Main Window)..........................................................  11, 82

About This Instruction Manual
It is prohibited to reproduce, in whole or part, the contents of this 
Instruction Manual without permission.
Canon may change without notice the software specifications and 
contents of this Instruction Manual.
The software screens and displays printed in this Instruction Manual 
may differ slightly from the actual software.
The content of this Instruction Manual has been reviewed thoroughly. 
However, if you should notice any errors or omissions, please contact 
a Canon Service Center.
Please note that irrespective of the above-mentioned, Canon does 
not take responsibility for the outcome of the operation of the 
software.

Trademark Acknowledgments
Microsoft and Windows are registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries.
Other names and products not mentioned above may be registered 
trademarks or trademarks of their respective companies.
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